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P r e F A c e

ix

As design engineers and engineering professors, the authors have wit-
nessed incredible changes in the way that products are designed and man-
ufactured. One of the biggest changes over the past 20 years has been the
development and widespread usage of solid modeling software. When we
first saw solid modeling, it was used only by large companies. The cost of
the software and the powerful computer workstations required to run it,
along with the complexity of using the software, limited its use. As the cost
of computing hardware dropped, solid modeling software was developed
for personal computers. In 1995, the SolidWorks Corporation released the
initial version of SOLIDWORKS® software, the first solid modeling pro-
gram written for the Microsoft Windows operating system. Since then, the
use of solid modeling has become an indispensable tool for almost any
company, large or small, that designs a product.

One application of solid modeling in the design process, additive man-
ufacturing, is illustrated on the cover of this book. The flange modeled
in Chapter 5 is converted to a stereolithograhy file, in which the sur-
faces of the part are represented by series of triangles. This file is then
transferred to one of the many types of additive manufacturing
machines (commonly referred to as 3D printers), where a physical pro-
totype can be made quickly. The prototype can be used to verify fit with
other parts or tested for functionality. In some cases, fully functional
parts can be made with additive manufacturing. The part on the cover
was made with a Formlabs Form 2 stereolithography printer, which
uses a laser to cure liquid resin layer-by-layer to produce a part.
Additive manufacturing is discussed further in Chapter 13.

SOLIDWORKS is a registered trademark of Dessault Systémes SolidWorks Corporation.
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Motivation for this text
When we saw a demonstration of the SOLIDWORKS software in 1998,
we were both instantly hooked. Not only was the utility of the software
obvious, but the program was easy to learn and fun to use. Since then,
we have shared our enthusiasm with the program with hundreds of stu-
dents in classes at Milwaukee School of Engineering and East Carolina
University, in summer programs with high school students, and in infor-
mal training sessions. Most of the material in this book began as tutori-
als that we developed for these purposes. We continue to be amazed at
how quickly students at all levels can learn the basics of the program,
and by the sophisticated projects that many students develop after only
a short time using the  software.

While anyone desiring to learn the SOLIDWORKS program can use
this book, we have added specific elements for beginning engineering
students. With these elements, we have attempted to introduce students
to the design process and to relate solid modeling to subjects that most
engineering students will study later. We hope that the combination 
of the tutorial style approach to teaching the functionality of the soft-
ware together with the integration of the material into the overall study
of engineering will motivate student interest not only in the
SOLIDWORKS software but in the profession of  engineering. 

Philosophy of this  text
The development of powerful and integrated solid modeling software
has continued the evolution of  computer- aided design packages from
drafting/graphical communication tools to  full- fledged engineering
design and analysis tools. A solid model is more than simply a drawing
of an engineering component; it is a true virtual representation of the
part, which can be manipulated, combined with other parts into com-
plex assemblies, used directly for analysis, and used to drive the manu-
facturing equipment that will be used to produce the  part. 

This text was developed to exploit this emerging role of solid modeling
as an integral part of the engineering design process; while proficiency
in the software will be achieved through the exercises provided in the
text, the traditional “training” exercises will be augmented with infor-
mation on the integration of solid modeling into the engineering design
process. These topics  include:

•    The exploitation of the parametric features of a solid model, to
not only provide an accurate graphical representation of a part but
also to effectively capture an engineer’s design intent, 

•    The use of solid models as an analysis tool, useful for determining
properties of components as well as for virtual prototyping of
mechanisms and systems,

•    The integration of solid modeling with component manufacturing,
including the generation of molds, sheet metal patterns, and rapid
prototyping files from component  models.

x Preface
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Through the introduction of these topics, students will be shown not
only the powerful modeling features of the SOLIDWORKS program,
but also the role of the software as a  full- fledged integrated engineer-
ing design  tool. 

the use of this  text
This text primarily consists of chapter-long tutorials, which introduce
both basic concepts in solid modeling (such as part modeling, drawing
creation, and assembly modeling) and more advanced applications of
solid modeling in engineering analysis and design (such as mechanism
modeling, mold creation, sheet metal bending, and rapid prototyping).
Each tutorial is organized as “keystroke- level” instructions, designed
to teach the use of the  software. For easy reference, a guide to these
tutorials is shown on the inside front cover.

While these tutorials offer a level of detail appropriate for new profes-
sional users, this text was developed to be used as part of an introductory
engineering course, taught around the use of solid modeling as an inte-
grated engineering design and analysis tool. Since the intended audience
is undergraduate students new to the field of engineering, the text con-
tains features that help to integrate the concepts learned in solid modeling
into the overall study of engineering. These features  include:

•    Design Intent Boxes: These are intended to augment the
“keystroke-level” tutorials to include the rationale behind the
sequence of operations chosen to create a  model. 

•    Future Study Boxes: These link the material contained in the
chapters to topics that will be seen later in the academic and
professional careers of new engineering students. They are
intended to motivate interest in advanced study in engineering,
and to place the material seen in the tutorials within the context of
the  profession.

While these features are intended to provide additional motivation and
context for beginning engineering students, they are  self- contained, and
may be omitted by professionals who wish to use this text purely for the
software  tutorials.

new in this edition
This new edition of the text has been fully updated for the
SOLIDWORKS 2017 software package. All tutorials and figures have
been modified for the new version of the software.

the organization of this  text
The organization of the chapters of the book reflects the authors’ prefer-
ences in teaching the material, but allows for several different options.
We have found that covering drawings early in the course is helpful in
that we can have students turn in drawings rather than parts as home-

Preface xi
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work assignments. The eDrawings feature, which is covered in Chapter
2, is especially useful in that eDrawings files are small (easy to  e- mail),
 self- contained (not linked to the part file), and can be easily marked up
with the editing tools contained in the eDrawings  program.

The flowchart on the following page illustrates the relations between chap-
ters, and can be used to map alternative plans for coverage of the material.
For example, if it is desired to cover assemblies as soon as possible (as
might be desired in a course that includes a project) then the chapters can
be covered in the order 1-3-4-6-7-2-8, with the remaining chapters covered
in any order desired. An instructor who prefers to cover parts, assemblies,
and drawings in that order may cover the chapters in the order 1-3-4-5-6-
7-2-8 (skipping section 5.4 until after Chapter 2 is covered), again with the
remaining chapters covered in any  order.

Chapters 9 and 10 may be omitted in a standard solid modeling course; how-
ever, they can be valuable in an introductory engineering course.
Engineering students will almost certainly find use at some point for the 
2-D layout and vector mechanics applications introduced in these chapters.
Chapter 13 is intended to wrap up the course with a discussion of how solid
modeling is used as a tool in the product development  cycle. Appendix A
summarizes the recommended settings to the SOLIDWORKS program that
are used throughout the book, while Appendix B shows options for cus-
tomizing the SOLIDWORKS interface.

xii Preface
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resources for Instructors
Additional resourses are available on the web at www.mhhe.com/
howard2017. Included on the website are tutorials for three popular
SOLIDWORKS Add-Ins, SOLIDWORKS® Simulation, SOLIDWORKS®

MotionTM and PhotoView360, and the book figures in PowerPoint format.
Instructors can also access PowerPoint files for each chapter and model files
for all tutorials and end-of-chapter problems as well as a teaching guide (pass-
word-protected; contact your McGraw-Hill representative for access).
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3

1C H A P T E R
Basic Part 
Modeling Techniques

1 SoliDWorkS is a registered trademark of Dassault Systémes SolidWorks Corporation.

Chapter Objectives

In this chapter, you  will:

■ be introduced to the
role of solid modeling in
engineering design,

■ learn how to create 2-D
sketches and create 3-D
extruded and revolved
geometry from these
sketches,

■ use dimensions and 
relations to define the
geometry of 2-D 
sketches,

■ add fillets, chamfers, and
circular patterns of fea-
tures to part models,

■ learn how to modify part
models, and 

■ define the material and
find the mass properties
of part models.

Introduction

Solid modeling has become an essential tool for most companies that
design mechanical structures and machines. Just 20 years ago, this
would have been hard to imagine. While 3-D modeling software
existed, it was very expensive and required high-end computer worksta-
tions to run. An investment of $50,000 or more was required for every
workstation with software, not including training of the operator. As a
result, only a few industries used solid modeling, and the trained 
operators tended to work exclusively with the software. The dramatic
performance improvements and price drops of computer hardware,
along with increased competition among software vendors, have signif-
icantly lowered the cost barrier for companies to enter the solid model-
ing age. The software has also become much easier to use, so that
engineers who have many other job functions can use solid modeling
when required without needing to become software specialists. The
SoliDWorkS®1 program was among the first solid modeling pro-
grams to be written exclusively for the Microsoft Windows environ-
ment. Since its initial release in 1995, it has been adopted by thousands
of companies worldwide. This text is laid out as a series of tutorials that
cover most of the basic features of the SoliDWorkS program.
Although these tutorials will be of use to anyone desiring to learn the
software, they are written primarily for freshmen engineering students.
Accordingly, topics in engineering design are introduced along the way.
“Future Study” boxes give a preview of coursework that engineering
students will encounter later, and relate that coursework to the solid
modeling tutorials. in this first chapter, we will learn how to make two
simple parts with SoliDWorkS software.
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4 Part One learning SoliDWorkS

Engineering Design and Solid Modeling

The term design is used to describe many endeavors. A clothing designer creates 
new styles of apparel. An industrial designer creates the overall look and function 
of consumer products. Many design functions concentrate mainly on aesthetic 
considerations—how the product looks, and how it will be accepted in the market-
place. The term engineering design is applied to a process in which fundamentals
of math and science are applied to the creation or modification of a product to meet
a set of objectives.

Engineering design is only one part of the creation of a new product. Consider a
company making consumer products, for example bicycles. A marketing depart-
ment determines the likely customer acceptance of a new bike model and outlines
the requirements for the new design. industrial designers work on the preliminary
design of the bike to produce a design that combines functionality and styling that
customers will like. Manufacturing engineers must consider how the components of
the product are made and assembled. A purchasing department will determine if
some components will be more economical to buy than to make. Stress analysts will
predict whether the bike will survive the forces and environment that it will experi-
ence in service. A model shop may need to build a physical prototype for marketing
use or to test functionality.

During the years immediately following World War ii, most American companies
performed the tasks described above more or less sequentially. That is, the design
engineer did not get involved in the process until the specifications were completed,
the manufacturing engineers started once the design was finalized, and so on. 
From the 1970s through the 1990s, the concept of concurrent engineering became
widespread. Concurrent engineering refers to the process in which engineering tasks
are performed simultaneously rather than sequentially. The primary benefits of con-
current engineering are shorter product development times and lower development
costs. The challenges of implementing concurrent engineering are mostly in 
communications—engineering groups must be continuously informed of the actions
of the other groups.

Solid modeling is an important tool in concurrent engineering in that the various
engineering groups work from a common database: the solid model. in a 2-D CAD
(Computer-Aided Design) environment, the design engineer produced sketches of
the component, and a draftsman produced 2-D design drawings. These drawings
were forwarded to the other engineering organizations, where much of the informa-
tion was then duplicated. For example, a toolmaker created a tool design from
scratch, using the drawings as the basis. A stress analyst created a finite element
model, again starting from scratch. A model builder created a physical prototype by
hand from the drawing parameters. With a solid model, the tool, finite element
model, and rapid prototype model are all created directly from the solid model file.
in addition to the time savings of avoiding the steps of recreating the design for the
various functions, many errors are avoided by having everyone working from a
common database. Although 2-D drawings are usually still required, since they are
the best way to document dimensions and tolerances, they are linked directly to the
solid model and are easy to update as the solid model is changed.

1.1
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Chapter 1 Basic Part Modeling Techniques   5

A mechanical engineering system (assembly) may be composed of thousands of
components (parts). The detailed design of each component is important to the
operation of the system. in this chapter, we will step through the creation of simple
components. in future chapters, we will learn how to make 2-D drawings from a
part file, and how to put components together in an assembly file.

Part Modeling Tutorial: Flange

This tutorial will lead you through the creation of a simple solid part. The part, a
flange, is shown in Figure 1.1 and is described by the 2-D drawing in Figure 1.2.

Begin by double-clicking the SOLIDWORKS icon on your desktop. Click on the New
icon, as shown in Figure 1.3. If the Units and Dimension Standard box appears, as
shown in Figure 1.4, select “IPS” as the units and “ANSI” as the standard. Click OK.

FIGURE 1.1 FIGURE 1.2

FIGURE 1.4FIGURE 1.3

1.2
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The Units and Dimension Standard box only appears the first time SoliDWorkS is
opened. The selections become the default values for all new files. in this chapter, we will
see how to set these values for individual files and to change the default values.

A dialog box will appear, from which you are to specify whether we are creating a part,
an assembly, or a drawing (see Figure 1.5).

Click OK to accept Part as the type of file.

Before we begin modeling the flange, we will establish a consistent setup of the SoliD-
WorkS environment. The default screen layout is shown in Figure 1.6. The graphics area
occupies most of the screen. The part, drawing, or assembly will be displayed in this area.
At the top of the screen is the Menu Bar, which contains the Main Menu and a toolbar with
several commonly-used tools such as Save, Print, and redo. Note that if you pass the cur-
sor over the SoliDWorkS button in the Menu Bar, the Main Menu will “fly out,” or be

6 Part One learning SoliDWorkS

FIGURE 1.5

FIGURE 1.6
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temporarily displayed, as shown in Figure 1.7. The fly-out feature is
designed to save room on the screen. However, since we will be using the
menu often, we will disable the fly-out so that the menu is always dis-
played.

Move the cursor over the SOLIDWORKS button to display the menu.
Click on the pushpin icon at the right side of the menu, as shown in
Figure 1.8, to lock the display of the menu.

The CommandManager contains most of the tools that
you will use to create parts. When working in the part
mode, there are two categories of tools that we will use
extensively: Sketch tools used in creating 2-D
sketches, and Features tools used to create and modify
3-D features. Clicking on the Sketch and Features tabs
at the bottom of the CommandManager, as shown in Figure 1.9,
changes the tools on the CommandManager to those of the selected
group. By default, there are several other groups available besides
the Sketch and Features groups. To simplify the interface, we will
hide these groups for now.

Right-click on one of the
CommandManager tabs. A
list of available groups is
displayed, with a check
mark shown beside each active group (Figure
1.10). Click on any of the active groups other
than Features and Sketch. This will clear the
check mark and turn off the display of that
group. Repeat until only the Features and
Sketch groups remain active.

At the right side of the screen is the Task
Pane. The Task Pane is a fly-out interface for
accessing files and online resources. We will
not use the Task Pane that often, but since it
takes up very little room in its normal col-
lapsed state, we will leave it on. if you would

like to turn it off completely, select View: User
interface from the Main Menu and click on Task
Pane.

At the bottom of the screen is the Status Bar. When
you move the cursor over any toolbar icon or menu
command, a message on the left side of the Status
Bar describes the command. other information

appears at the right side of the Status Bar, as shown in Figure 1.11. The unit system in
use is displayed and can be changed directly from the Status Bar. Another feature, called
Tags, allows keywords to be associated with files and features. We will not be using
Tags in this book. Although the display of the Status Bar can be toggled off and on from
the View menu, we recommend leaving it on.

Chapter 1 Basic Part Modeling Techniques   7

FIGURE 1.7

FIGURE 1.8

FIGURE 1.9

FIGURE 1.10

FIGURE 1.11
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8 Part One learning SoliDWorkS

Just to the left of the drawing area is the FeatureManager® Design Tree. The
steps that you will execute to create the part will be listed in the FeatureManager.
This information is important when the part is to be modified. When you open a
new part, the FeatureManager lists an origin and three predefined planes (Front,
Top, and right), as shown in Figure 1.12. As you select each plane with your
mouse, the plane is highlighted in the graphics area. We can create other planes
as needed, and will do so later in this tutorial.

At the top of the graphics area is the Heads-Up View Toolbar. This toolbar con-
tains many options for displaying your model. We will explore these options
later in this tutorial.

We will now set some of the program options.

Select the Options Tool from the Menu Bar toolbar, as shown in Figure 1.13.
(You can also access the options from the Main Menu, by selecting Tools:
Options.)

The dialog box contains settings for both the system and for
the specific document that is open.

Under the System Options tab, choose Colors and change the
icon color to “Classic” and the color scheme to “Green
Highlight,” as shown in Figure 1.14.

The Classic option for icon colors makes many of the icons
display in colors other than the default blue and black, making
them easier to recognize for new users. The Green Highlight
scheme causes currently selected items to be highlighted in
green, as the name implies. The default option is for selected
items to be highlighted in light blue. Since another shade of
blue is used for other purposes, green highlighting is used in
this book to avoid confusion. Since these changes were made
to the System options, they will remain in effect for future
SoliDWorkS sessions. The changes below, which will be
made to the Document Properties, will apply only to the cur-
rent part model.

Select the Document Properties tab. In the list of options,
Drafting Standard will be highlighted. Select ANSI from the
pull-down menu, as shown in Figure 1.15.

ANSi is the American National Standards institute, an orga-
nization that formulates and publishes the standard drawing
practices used by most companies in the United States.
European companies are more likely to use the standards of
iSo, the international organization for Standardization.

Also under the Document Properties tab, select Dimensions. Use the pull-down
menu by the Primary precision box to set the number of decimal places to 3 (.123),
as shown in Figure 1.16. Select Grid/Snap and check the box labeled “Display Grid,”

FIGURE 1.12

FIGURE 1.15

FIGURE 1.16

FIGURE 1.13

FIGURE 1.14
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as shown in Figure 1.17. Also, select Units and set the unit sys-
tem to IPS (inches. pounds, and seconds), the primary length
precision to .123 and the precision for angles to None, as
shown in Figure 1.18.

Note that there are “Dual Dimension” units that can be set in
the Units options. For some drawings, you may want to show
dimensions in both US units (inches) and Si units (millime-
ters). Since we will not use dual dimensions for this part, it is
not necessary to change the default settings. Also note that we have set
the decimal display to .123 in two separate locations. The display of
decimal places can be changed at either location.

Click OK to close the dialog box.

Any of the options just set can be changed at any time during the model-
ing process. later in this chapter, we will learn how to create a template
that allows us to begin a new part with our preferred settings in place.

We will make two more changes to the default settings before beginning our
part. A feature called “instant 3D” allows for changes to be made by clicking
and dragging on model faces, without entering dimensions from the keyboard.
While this feature can be handy for experienced users, it is recommended that
new users avoid using instant 3D in order to prevent unintended changes to the
model. Similarly, a feature called “instant 2D” allows for dimensions in
sketches to be changed by clicking and dragging rather than entering a numer-
ical value. This feature will also be turned off.

Select the Features tab of the CommandManager. If the Instant 3D Tool is
turned on (the icon will be “depressed,” as shown in Figure 1.19), click to
turn it off. Select the Sketch tab of the CommandManager and turn off the
Instant 2D Tool as well.

We start the construction of the flange by sketching a circle and extruding it
into a 3-D disk.

Select the Front Plane by clicking on it in the FeatureManager Design Tree,
as shown in Figure 1.20.

The Front Plane will be highlighted in green. The
color green indicates that an item is the currently
selected entity (since we chose the “Green
Highlight” color scheme).

Begin a sketch by selecting the Sketch tab of
the CommandManager, and then the Sketch
Tool, as shown in Figure 1.21.

Note that when you selected the Front Plane, a pop-up menu appeared that allowed
you to open a sketch on that plane, as shown in Figure 1.22. The SoliDWorkS
program has many of these context-sensitive menus built in. As you become profi-
cient with the program, you may find many of these built-in shortcuts to be handy. 

Chapter 1 Basic Part Modeling Techniques   9

FIGURE 1.20

FIGURE 1.17

FIGURE 1.18

FIGURE 1.21

FIGURE 1.19

FIGURE 1.22

how96545_ch01_001-054.qxp_HowardMusto-design.qxd  3/15/17  3:49 PM  Page 9




